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Manuscript that will be Distributed to | 18 point verdana |
Students and Published in Journal/Proceedings

Note that any additional instructor supporting materials (PowerPoints, Exercise Answers, videos, data sets,
etc.) should be in a separate file(s). See Case Supporting Materials for details

Initial Submission: Leave space (5 lines for each other) for Author
Information to be inserted later. Please make sure you update all author
information in the papers system as you submit and upload (or reupload).
Your final accepted submission should detail author information as: Name,
Email, College, City, State, Country as in

sampleAuthor Name
sampleAuthor@email.edu
Sample Author University
College City, State, Zip, Country

12 point heading

12 point headings For
Hook Hook & Abstract

“Hook” statement that generates interest in the case or activity. Think of this like a phrase that you
might see on a poster advertising a motion picture.

9 point Verdana
this point forward Abstract

The abstract should summarize the content of the paper. Make it a single paragraph. Try to keep it
below 250 words and do not include equations or references in it. If you use abbreviations in the paper,
i.e., CIS, use the full meaning of the abbreviation in the abstract or at first use, i.e., Computer
Information Systems.

Keywords: Select four to six keywords that capture the essence of the paper. List the words in
decreasing order of importance from left to right, with commas between the key word concepts. Also
enter the Keywords into the papers system when submitting.

Overall Guidelines to help make your paper accepted sooner:

1. Check your line spacing under paragraph, and check that it is SINGLE as the default on some
versions of Word is 1.15.

2. Check your header / footers to ensure they are .4 inches (from top/bottom), not .5 as we receive
from many people.

3. The text of the conference is English. Your paper must not contain corrections, nor should they
contain page numbers, headers or footers.


mailto:sampleAuthor@email.edu
https://iscap.us/papers/docs/submissions/ISCAPCasesSupporting.pdf
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4. Please avoid using the built-in styles, especially if you are using a MAC, as the styles don't
always translate back to PCs with the same look and feel.

5. Avoid using text boxes for images or figure/table numbers. Insert them in the ‘flow’ of your
normal paragraphs. The reason is when we insert author names and other information, the
position of text boxes generally does not move and then overlap your content.

6. Paper submissions must be limited to 5000 words (max), excluding appendices and references
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Page 2: Insert your Case Title
here in Verdana - 14 font.

Leave this line here to insert author names in the final formatted submission

Overall Guidelines

The appearance of the ISCAP Conference proceedings and the ISCAP journals are greatly enhanced by
standardized formatting. Formatting is the same for both Conference and Journal submissions. This
template is needed only for Conference submission, as you’ll be asked to make updates to your final
Conference proceedings paper (returned to you with the Journal invite) for the Journal review.

The only format accepted will be Microsoft Word documents. Please submit in .docx format (if your file
is above 4 MB, please prepare the document in Word and then Zip the file).

For initial submission, please remove personal identifying information from document content and
metadata. To remove Word metadata: File > Info > Check for Issues > Inspect Document >Document
Inspector > Document Properties and Personal Information > Remove All.

The entire document layout (every page) should be set to 1.0 top margin, 1.0 bottom margin, 1.0 left
margin, and 1.0 right margin. While on the Page Layout Tab, change the Hyphenation Option to
NONE.

Set your pages to full justification. Do not use any headers, footers, page numbers or footnotes in your
document. If you have any headers/footers, please delete them as they will interfere with the conference
information we will place in the header/footer when published to the web.

Set the font to Verdang, 9pt., if you have it available. Use a 9 pt font for the body of the paper. If you
do not have Verdana use Times New Roman.

Use the paragraph / spacing options to set paragraphs to alignment justified, indent zero, spacing
before to Opt, [spacing after to Opt, and line spacing zero. IPIease check your paragraph line spacing as
the newer MS templates default the line spacing to 1.15, please revise to single.

Place a single blank line between paragraphs. Use a single space at the end of each sentence and a
single space after colons.

Title

The title should be Verdana 18 pt font on the first page and 14 pt font on the second page, Mixed Case
(not UPPER CASE), not bold. You may insert soft returns (shift enter) into long titles to improve
readability. Center your title. Because the first page top margin is 1.0 inches, please add a blank line
(18 pt) before the title.

Abstract
The word “Abstract” should be centered in Verdana 9 pt bold. The rest of the abstract and the keywords
should be Verdana 9 pt font. The word “Keywords:” should be bold. The abstract should not exceed 250

words.

Keywords: Select four to six keywords that capture the essence of the paper. List the words in
decreasing order of importance from left to right.
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1. MAJOR SECTION HEADINGS
Major headings are to be centered, numbered, in a capitalized bold font as shown in this document.
Leave a blank row before and after Major Section Headings. Do not use the Microsoft Paragraph
Numbering Option as it will not center the heading properly.
1.1 Subheadings
Subheadings should be bold font with initial capitals and left-justified. Insert one line before the
subheading title, and one line after the subheading. Number the subsections manually and do not use
the MS numbering option.

Both major headings and subheadings should be set to “Keep with Next” so that they stay with their
content as the paper may be slightly edited.

1.2 Figures / Tables

Figures and tables should be placed in the manuscript on the page where they are referenced (if they
fit). Please attempt to have your figures and tables to span only one page. Larger tables and figures
should be moved to the appendix. Use Section Breaks (Continuous) to maintain the location to of your
tables and figures. Do not place the descriptions of figures / tables in text boxes.

Place the identifying information about tables and figures below the Figure or Table in bold and
centered. Do not use jtalics. Use a period to separate the table or figure number from a brief and
descriptive caption. They should be humbered consecutively throughout the text.

1.3 Formulae

All equations must be typed utilizing a suitable processor. They should be numbered consecutively

throughout the text, at the flush-right edge of the equation, enclosed in parentheses. It is acceptable
to present formulas as images if necessary.

1.4 Teaching / Supplemental Materials

For teaching cases, it is recommended that authors include supporting materials. These should be
materials that make it easier for a reader to adopt the case. Examples of materials include, but are not
limited to, instructor notes, PPTs, spreadsheets, worksheets, etc.

Metadata for these materials should be removed in the same manner as the case itself: File > Info >
Check for Issues > Inspect Document >Document Inspector > Document Properties and Personal
Information > Remove All.

Supplemental materials should be in separate file(zip) and uploaded after you submit the case. Please
note your zip file must be less than 4 MB to be uploaded, if it is larger than 4 MB send directly to the
case editor (cases@isedj.org) with the case # in your email.

2. CONCLUSIONS

The enhancements to information systems and computing educators are identified. DO NOT repeat the
abstract or portions of it.

3. ACKNOWLEDGEMENTS
Place before the references.
4. FOOTNOTES

Do not use footnotes, use Endnotes instead, however both are discouraged.
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5. REFERENCES
We request you follow the APA (American Psychological Association) guidelines to cite sources. Please
include Digital Object Identifiers (DOI) links for all references where possible. DOI citations should
follow the_APA guidelines.
Following are examples of typical citation items:

Ashby, W. R. (1956). An Introduction to Cybernetics. Methuen Press, London. (Book)

Harris, A. (2009). Publishing in JISE. Journal of Information Systems Education, 7(1), 12-15.
https://doi.org/xxxxx (Journal with 1 Author and DOI reference).

Harris, A., & Harris J. (2010). Publishing in JISE. Journal of Information Systems Education, 7(1), 12-
15. https://doi.org/xxxxx (Journal with 2 Authors)

Harris, A., Harris J., & Colton D. (2011). Publishing in JISE. Journal of Information Systems Education,
7(1), 12-15. https://doi.org/xxxxx (Journal with 3 or more Authors)

Hunsinger, S. (2010). My life with Word Press. In M. Smith (Ed.), Word Press in the 215t Century . High
Point Press. (Book Chapter with Editor)

Sample, P., & Canary, W. (2008). Why Web 2.0 implies I should get a raise. New England Online
Education 7(12). Retrieved June 6, 2010 from https://giveaddress.com/xxx (Online Journal or
Publication or Article)

White, B. (2009, June 1). Why June is a great month to submit an article to ISCAP. Chronicle of Higher
Education, 22(7), 15-16. (Magazine Article)

When citing references in the text, include the last name and year. The citation should appear in
parentheses such as (Ashby, 1956) or, if you need to comment about Ashby (1956) stated we are
great.

Two author papers should be cited in the document as (Harris & Witman, 2009).

Three or more authors in a paper should be cited with the name of the first author and “et al.” in each
instance, including the first citation: (Harris et al., 2009). The only exception would be if doing so would
create ambiguity.

If two or more papers are cited by the same author, separate the years with commas. Identical years
for the same author should appear as (2009a) and (2009b) in the body of the document as well as the
references.

If the author of a paper is not provided, alphabetize according to the title of the work. If the first word
in the title is a number, alphabetize as if the number were a written word, for example, 10 Best
Practices” would be alphabetized as though it were written as the word “ten.”


https://nam12.safelinks.protection.outlook.com/?url=https%3A%2F%2Fapastyle.apa.org%2Fstyle-grammar-guidelines%2Freferences%2Fdois-urls&data=05%7C01%7Cjanickit%40uncw.edu%7Ca779273c6a8d4408884708dbea9da114%7C2213678197534c75af2868a078871ebf%7C0%7C0%7C638361734973905052%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=kVNFg3SGT3yu7qF3dObsY0k3qVnQZJlhJ3MIypaWw1A%3D&reserved=0
https://doi.org/xxxxx
https://doi.org/xxxxx
https://doi.org/xxxxx
https://giveaddress.com/xxx
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Appendices

Typically, an appendix or annexure will include actual handouts given in class, or questionnaires used
for surveys, or other presentation graphics and tables that do not fit readily into the body of the
paper but are still important for clarity or completeness. Often these items were prepared for other
purposes than presentation as a part of your paper, and it is acceptable that they do not adhere to font
face, font size, and column requirements observed elsewhere in your paper.

In appendices, you are allowed to have margins that are larger but not smaller than the
generally required margins, which are 1.0 top margin, 1.0 bottom margin, 1.0 left margin, and 1.0
right margin

So long as you adhere to the margin requirements, appendices may be presented in any format that
you desire.

Rotated pages (landscape orientation) are not allowed in the body of the document, but they are
permitted in the appendices. This will allow the entire page to be rotated anti-clockwise 90 degrees for
final formatting.

Please label each appendix section with a serially lettered heading in all caps/bold, e.g., APPENDIX A.

The following line should give title of that appendix section, in mixed case/bold, e.g., Title of Content
for this Part of the Appendices.

APPENDIX A

Describe what is in the appendix



